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YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT 
BEFORE OPENING THIS PACKAGE. IF YOU DO NOT AGREE WITH THESE TERMS AND CONDITIONS, PLEASE 
PROMPTLY RETURN THIS PACKAGE FOR A FULL REFUND.

LICENSE AGREEMENT
Brady Worldwide, Inc. (hereafter "Brady") hereby grants you a non-exclusive, nontransferable license to use this 
software and the accompanying documentation according to the following terms:
1. LICENSE GRANT: You may 1) install the software on the number of computers covered by invoices for this 
license from Brady, which are hereby incorporated by reference; 2) use and transmit the software on a network 
within a site if authorized by an invoice from Brady; 3) install the software on one server or multiple servers as 
invoiced for a single server or multiple servers which invoices are hereby incorporated by reference; and 4) make 
copies of the software in machine readable form for backup purposes only. 
2. LICENSE RESTRICTIONS: You may not: 1) modify, adapt, translate, reverse engineer, decompile, disassemble, 
create derivative works based on, or copy (except for the backup copy) the software or the accompanying 
documentation; 2) rent, transfer or grant any rights in the software or accompanying documentation without the prior, 
express written consent of Brady; or 3) remove any proprietary notices, labels, or marks on the software and 
accompanying documentation.
3. NATURE OF THIS AGREEMENT: This license is not a sale. License fees paid by you, if any, are in consideration 
of the licenses granted under this Agreement. Title and copyrights to the software, accompanying documentation, 
and any copy made by you, remain the property of Brady or its suppliers. Unauthorized copying of the software or 
the accompanying documentation, or failure to comply with the above restrictions, shall automatically terminate this 
license, without further notice, and terminate your rights to use the software, and Brady shall, in addition to its other 
legal remedies, be entitled to its reasonable attorney fees.
4. LIMITED WARRANTY: Brady warrants that, for a period of ninety (90) days from the date of delivery to you as 
evidenced by a copy of your receipt, the software, as furnished, under normal use, will perform without significant 
errors. Brady's entire liability and your exclusive remedy under this warranty (which is subject to you returning the 
software to Brady) will be, at the option of Brady, to attempt to correct or help you around errors, to replace the 
software with functionally equivalent software or diskettes, or to refund the license fee of the software and terminate 
this Agreement.
EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY, BRADY MAKES AND YOU RECEIVE NO 
WARRANTIES, EXPRESS, IMPLIED, STATUTORY OR IN ANY COMMUNICATION WITH YOU, AND BRADY 
SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE. BRADY DOES NOT WARRANT THAT THE OPERATION OF THE PROGRAM WILL BE 
UNINTERRUPTED OR ERROR FREE.
Some states do not allow the exclusion of implied warranties so the above exclusions may not apply to you. This 
warranty gives you specific legal rights. You may also have other rights which vary from state to state.
5. LIMITATION OF LIABILITY: IN NO EVENT WILL BRADY BE LIABLE FOR ANY DAMAGES, INCLUDING LOSS 
OF DATA, WHEN LOADING THIS SOFTWARE OR OTHERWISE, OR LOST PROFITS, COST OF COVER OR 
OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES ARISING FROM THE USE OF 
THE PROGRAM OR ACCOMPANYING DOCUMEN-TATION, HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY. THIS LIMITATION WILL APPLY EVEN IF BRADY HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGE.
Some states do not allow the limitation or exclusion of liability for incidental, or consequential damages, so the above 
limitation may not apply to you.
6. GENERAL: This Agreement shall be governed by, and interpreted under, the laws of the State of Wisconsin, USA.   
You acknowledge that U.S. law and regulations may restrict the export/re-export of the software. You agree not to 
export/re-export the software or portions thereof in any form without the appropriate U.S. and foreign government 
licenses. This obligation shall survive and continue after this Agreement terminates. This Agreement is the entire 
agreement between the parties and supersedes any other communications or advertising with respect to the 
software and accompanying documentation. If any provision of this Agreement is held invalid, the remainder of this 
Agreement shall continue in full force and effect.

6555 West Good Hope Road, P.O. Box 571, Milwaukee, Wisconsin 53201-0571, USA, tlf. +1 (414) 358-6600
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Copyright
This manual is copyrighted with all rights reserved. No portion of this manual may be copied or 
reproduced by any means without the prior consent of Brady Worldwide, Inc.

While every precaution has been taken in preparation of this document, Brady assumes no liability to 
any party for any loss or damage caused by errors or omissions or by statements resulting from 
negligence, accident, or any other cause. Brady further assumes no liability arising out of the 
application or use of any product or system described, herein; nor any liability for incidental or 
consequential damages arising from the use of this document.  Brady disclaims all warranties of 
merchantability or fitness for a particular purpose.  

Brady reserves the right to make changes without further notice to any product or system herein to 
improve reliability, function, or design.

Reproduction of this material, in part or whole, is strictly prohibited without the written permission of 
Brady Worldwide, Inc.. For more information, contact: Brady Worldwide, Inc. Signmark® Division, 
2221 W. Camden Road, Milwaukee, WI 53209.

Disclaimer
Every effort has been made to make this guide as accurate and complete as possible. Brady 
Worldwide, Inc. is not responsible for inaccuracies and omissions occurring during the use of this 
guide.

This manual is proprietary to Brady Worldwide, Inc. and may be revised from time to time without 
notice.  Brady Worldwide, Inc. disclaims any understanding to provide you with revisions, if any.

All brand or product names referenced in this manual are trademarks or registered trademarks of their 
respective companies or organizations.

LOCKOUT-PRO, GLOBALMARK, and HANDIMARK are trademarks of Brady Worldwide, Inc.

© 2008 Brady Worldwide, Inc. All rights reserved.

www.bradycorp.com
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Administering the Application

The Enterprise version of LOCKOUT-PROTM Graphical Procedure Writing Software includes an 
Enterprise Management tool that lets the Administrator easily manage usage across an entire 
organization. This Administrator’s Guide contains the following information:

• Enterprise Server Functions
- Installing & Setting Up Server Applications
- Initiating Network Service
- Activating the LOCKOUT-PROTM Application
- Distributing the Software

• Using the Enterprise Manager
- Starting & Stopping Network Service
- Connecting to the Network
- Managing User Groups
- Managing Users
- Managing Files & Folders

• Troubleshooting
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Enterprise Server Functions
LOCKOUT-PROTM Enterprise version is designed for larger organizations that want to deploy the 
software over a network to centralize control of user rights, templates, defaults and security. 
LOCKOUT-PROTM Enterprise combines server-side administrator utilities and a network service with 
the desktop application running on the client PC.

The primary components active on the LOCKOUT-PROTM Enterprise server are:

• Administrator Application
• Network Service

Administrator Application
The LOCKOUT-PROTM Enterprise Manager utility lets administrators monitor client users and files, 
register users, assign users to groups, and set user rights. The utility also lets administrators copy files 
from one group to another and unlock files that have been “checked out” and cannot be unlocked 
using the normal process (e.g., due to a client PC crash).

The Enterprise Manager is set up on the server only once. However, after setting up at least one 
administrator on the server, additional administrators can be established for administrators to run a 
“remote” version of the Enterprise Manager from their client PCs.

Network Service 
A network service running on the Enterprise server is the means by which client users connect to the 
server for access to online files. This service can be started and stopped using standard Windows® 
administrator tools (Services Function), or by using controls provided in the Enterprise Manager.

You can start and stop the service only from the server, using either the standard Windows tools or 
the Administrator Application. These functions cannot be performed when running the Enterprise 
Manager remotely.
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System Requirements 

Server Applications

Client PCs

LOCKOUT-PROTM Graphical Procedure Writing Software
.NET Framework v2.0 or higher

ASP.NET v2.0, installed

Network 
Connection

Access to the LOCKOUT-PROTM Enterprise Server over an intranet.

Protocol TCP/IP

IIS support v5 or v6, configured and enabled

Data Access 
Components

MDAC v2.8

Server Operating 
System

Microsoft® Windows® 2000 Server, Windows 2003 Server, or XP PRO (SP3). 

LOCKOUT-PROTM Graphical Procedure Writing Software
Processor Minimum: 1.2 GHz or better

Recommended: 2.6 GHz

Display Resolution Minimum: 800 x 600 or better
Recommended: 1024 x 768 High Color, 32 Bit

Memory Minimum: 512 MB RAM
Recommended: 1 G

Disk Space Minimum: 500 MB
Recommended: Same

Operating System Microsoft® Windows® 2000 (SP4), XP PRO (SP3) or Vista. 

Internet Explorer v6.0 or higher

Printer Drivers Drivers for your printer(s) should be installed. At least one printer must be 
installed to run the application. See your printer documentation for installation 
instructions.
GLOBALMARK® printers only: Updated driver is required. First, uninstall the 
printer and print driver from your computer. Install the new GLOBALMARKTM 
driver included on the LOCKOUT-PROTM installation CD.

Printers Supported GLOBALMARK™ Industrial Label Maker
HANDIMARKTM Printer (energy source labels only)
Sheet-fed laser or inkjet
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Enterprise Manager Main Menu & Functional Areas
The LOCKOUT-PROTM Enterprise Manager utility provides an easy-to-use interface to manage the 
enterprise server functions.

Main Menu
The Enterprise Manager utility consists of six functional areas. Each of the functions are accessed by 
buttons on the left side of the main menu. Figure 1 shows one of the windows available in the utility.

.

Figure 1.  Enterprise Manager Main Window
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Functional Areas
Table 1 lists the components and features of the Enterprise Manager main window and indicates 
which ones are not available when using the application remotely.

Table 1.  Enterprise Manager Functions

Enterprise Manager Functions Server Remote
Main Window: The Administrator Application opens to the last window displayed when the application 
was closed. The following windows included in the application:

Groups: Opens a window allowing you to add or delete user groups.

Users: Opens a window allowing you to add or delete users or change user 
information.

Files & Folders: Allows you to manage files and make copies of the 
procedure files so more than one group can use them.

Service: Allows you to start or stop LOCKOUT-PRO™ service, change the IP 
address and Port, or connect to a different server.

Config: Opens a window allowing you to set the language, enter the product 
key and set the web-viewer password.

Web Viewer Account: Allows you to set the security account used by the 
LOCKOUT-PRO™ viewer application.
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Install Enterprise Manager Applications
The following LOCKOUT-PROTM components are installed on the server:

• LOCKOUT-PROTM Enterprise Manager: Installed on a server and used by Administrators to 
manage the groups and users of the Client Application (LOCKOUT-PROTM software). 

• LOCKOUT-PROTM Graphical Procedure Writing Software: Installed on a server and contains 
all of the templates and defaults for the client users. Users create, edit, print and store 
procedures from the server. 

This section describes the requirements for installing the Enterprise Manager utility. See the 
appropriate sections for step-by-step instructions.

Preparing for Installation
The following Microsoft® applications are necessary for the full functionality of the LOCKOUT-PROTM 
applications and are available from www.microsoft.com. This website also provides extensive support 
documentation on how to install and configure these applications.

• Internet Information Services (IIS), v6.0 or above
• .NET Framework, v 2.0 
• Data Access Components, MDAC v2.8
• Active Directory
• ASP.NET, v2.0

Note: .NET Framework and MDAC are installed and updated automatically during the 
LOCKOUT-PROTM installation on a host server. However, for a remote install, 
.NET 2.0 and MDAC are not automatically installed. An installation link is included 
on the LOCKOUT-PROTM installation webpage. 

Although this guide provides the basic setup structure, be sure to consult your administrator before 
installing. Your administrator may require additional settings for security purposes, or may use a third-
party software package for client installation.
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Installing the Enterprise Manager Utility

To install the utility:

1. Insert the LOCKOUT-PROTM CD in the enterprise server CD-ROM drive and select Install LOP 
Enterprise Manager from the installation screen. 

- or -
If your PC does not automatically launch the installation screen, click Start>Run. Type 
x:\setup.exe (x corresponds to your CD-ROM drive) and click OK to install the software manually. 

2. In the Language box, select a language and click Next. 

3. In the Welcome screen, click Next.

4. In the License Agreement screen click the radio button to agree with the license terms, then click 
Next.

5. When prompted, enter the following, then click Next:

• Your name
• Company name
• Serial number (from the CD package)

6. In the Ready to Install screen, click Next to accept the default settings. The software is installed. 

7. In the Installation Successful screen, click Finish. 

8. Depending on your location, a registration form may display. You can submit your registration 
information now, or close the form and submit the registration later. 
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Initiating Network Service
Network service must be initiated before clients can access the LOCKOUT-PROTM Graphical 
Procedure Writing Software. The administrator initiates the network service from the Enterprise 
Manager. When initially launched, the Enterprise Manager utility opens to the Service window which 
displays:

• IP address for the local machine (default)
• Port (default 8032)

If changed, the Address and Port you selected are shown in subsequent launches. Once service is 
started, the remaining administrator buttons become available.

Note: Remote Administrators cannot start and stop the network service. 

To initiate network service:
1. In the Enterprise Manager utility, click Service.
2. Enter the IP Address and Port Number (if necessary).

3. Click Connect. Once the service is started, the remaining functions are available.
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Activating the LOCKOUT-PRO™ Application
Before clients can use the LOCKOUT-PROTM Graphical Procedure Writing Software, the application 
must be activated from the Enterprise Manager. 

The activation code is an encrypted key that specifies the number of licenses purchased by the 
organization. These are “floating licenses,” meaning that they can be used on any computer on the 
network, as long as the total number of licenses in use at any given time does not exceed the number 
of licenses purchased.

Change Enterprise Manager Language
1. In the Enterprise Manager utility, click Config.

2. In the Language drop-down list, choose the language in which you want the Enterprise Manager 
utility to run.

Note: This affects only the Enterprise Manager utility and has no effect on the language 
in which the client software runs. Client users can select the language individually 
on their client machines
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Change the Web Viewer Security Account

Client users can view LOCKOUT-PROTM procedures and/or related information through a web 
browser instead of using the client application. If the LOCKOUT-PROTM Viewer website security 
account is changed in IIS, the web viewer security account must be changed.

Note: Remote Administrators cannot perform this task.

To change a web-viewer security account:
1. In the Enterprise Manager utility, click Web Viewer Account. 

Notes: • Predefined account(s) depend on the operating system and default to the 
following:

• Windows XP: ASPNET
• Windows 2000 Server: IWAM_MachineName (default), 

IUSR_MachineName [where the MachineName is the name of the machine.]
• Windows 2003 Server: Network Service (default), Local Service, Local 

System
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2. To change to a different account, click Configurable, then do one of the following:

• Type the desired account user name.
• Click Browse to search for the account name.
• Click Advanced to enter more specific search criteria, then click Find Now (you can stop the 

search by clicking Stop). From the search results, select the desired account and click OK. The 
application closes the search dialog and displays the account name in the field on the Web 
Viewer Account screen.

Note: If you try to update existing data without entering an account name or entering an 
invalid account name, an error message is displayed and no changes are made to 
the existing data.

3. Click Update Now.

4. If there is existing company data, click OK at the prompt to update the Web Viewer account for 
existing companies.
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Set the File Repository Location
The File Repository location can be set only by the Local Administrator running on the 
LOCKOUT-PROTM server. Administrators logged in remotely cannot set the file repository location. 

1. In the Enterprise Manager, click Config.

2. In the File Repository box, enter a new LOCKOUT-PROTM file repository location, or click Browse 
and navigate to the location where you want the files stored.

3. Click OK. The existing data will be moved to the new repository location.

Enter a LOCKOUT-PRO™ Product Key
If you enter an invalid product key, a message displays indicating that a valid product key must be 
entered so the number of license(s) can be established. Until a valid product key is entered, the client 
application will not be accessible by users.

1. In the Enterprise Manager, click Config.
2. In the Product Key dialog, enter the Product Key. The product key is located on the 

LOCKOUT-PROTM installation CD.

3. Click Apply. The total number of available licenses the company is updated and displayed on the 
screen and the warning notice is removed.
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Distribute the LOCKOUT-PRO™ Software
After activating the LOCKOUT-PROTM software, you can distribute the software installation files to 
users’ computers, using either of these methods:

• Web Installer: Instruct clients to use the provided Web Installer, which offers an easy interface 
instructing users how to save the installation files and then install LOCKOUT-PROTM Graphical 
Procedure Writing Software.

• Microsoft® Group Management Policy: Use this tool to silently “push” the LOCKOUT-PROTM 
Graphical Procedure Writing Software installation files to the client machines. (You may also 
have a third-party software application that you use to perform such silent installs.)

Distributing the LOCKOUT-PRO™ Software to Clients
To install the LOCKOUT-PROTM Graphical Procedure Writing Software on a client PC, the following 
are required:

• Minimum PC requirements (see “System Requirements” on page 3
• Server has been set up to host the LOCKOUT-PROTM Graphical Procedure Writing Software

Web Installer

To install LOCKOUT-PROTM on client machines using the Web Installer:
1. Instruct the client user to browse to: http://<server name or IP address>/LOPClientSetup/.
2. Instruct the client user to:

a. Choose a different language, if desired.

b. Click on the LOCKOUT-PROTM v3.1 Download file.

c. Save the file to a location on their computer by clicking Save, or choosing to run the 
installation from the download site.

d. When the download is complete, double-click the file: Lockout PRO Enterprise Client.msi.

e. In the Windows Installer window, click Next.

f. When asked to confirm the installation, click Install.

g. After the program finishes installing, click Finish. A LOCKOUT-PROTM icon is added to the 
PC desktop.

Note: .NET Framework and MDAC are not automatically installed. A link is included on the 
LOCKOUT-PROTM installation webpage for installing these components.
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Group Policy (Push) Tool

To install LOCKOUT-PROTM on client machines using the Group Policy (Push) Tool:

Note: For help using the Microsoft® Group Policy Management tool, go to 
http://support.microsoft.com/kb/816102/. If using third-party software, refer to its user 
documentation for specific instructions on setting up a silent install of the 
LOCKOUT-PROTM application.

Note: Before installation, all of the group of PCs must have .NET 2.0 already installed.

1. Log in to the LOCKOUT-PROTM server.
2. Setup a shared folder to which all users have access.

3. From the file location [Install Directory]\LOPE\ClientFiles\, copy the file Lockout PRO Enterprise 
Client.msi to the shared folder.

4. In Windows, select Start>Administrative Tools>Group Policy Management.

Note: The Group Policy Management tool is only available with Windows® 2003 Server 
and Windows XP Professional. It is a free download from www.microsoft.com if it is 
not already on your server.

5. In the Group Management Policy navigation panel, under Forest, locate your domain and server.

6. In the Domain window (on the right side), right-click Default Domain Policy, and choose Edit.

7. From the Group Policy Object Editor window for your domain, choose from the following options to 
do a “Push” install for every:

• Computer: Under Computer Configuration, select the Software Settings folder.
• User: Under User Configuration, select the Software Settings folder.

8. Right-click on Software Installation, then choose New>Package.

9. Navigate to: My Network Places>Entire Network>Microsoft Windows Network>your 
domain>your server>[shared folder from step 2]>Lockout PRO Enterprise Client.msi file.

10. Click Open.

11. In the Deploy Software window, choose Assigned, then click OK.

12. In the Group Policy Object Editor window, double-click the Software Installation entry.

13. If you chose “User” in Step 7:

a. Right-click the file Lockout PRO Enterprise Client.msi, then select Properties. 
b. Click the Deployment tab.

c. Under Installation user interface options, choose Basic, then close the window.

14. The LOCKOUT-PROTM application will be installed on the user’s desktop:

• Users: At the next log on
• Computers: At next reboot.
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Distributing the Remote Administrator Application
You can distribute the LOCKOUT-PROTM Administrator Application to remote users PCs using either 
of these methods:

• Web Installer: Offers an easy interface instructing users how to save the installation files and 
then install LOCKOUT-PROTM Graphical Procedure Writing Software.

• Microsoft® Group Management Policy: Use this tool to silently “push” the installation files to the 
remote user PCs.

To install the application on a remote PC, the Enterprise Client must meet the following requirements:

• Minimum PC requirements
• Server has been set up to host the LOCKOUT-PROTM Enterprise application

Web Installer

To install Remote Administrator using the Web Installer:
1. Navigate to: http://<server name or IP address>/LOPRemoteAdmin/

2. Download the LOCKOUT-PROTM Remote Admin application.

3. To begin installation, double-click the downloaded file.

4. In the Windows Installer window, click Next.

5. When prompted, read and accept the license agreement by clicking Yes.

6. When prompted to choose the program folder, click Next to accept the default location.

7. In the Ready to Install screen, click Install to confirm the installation.

8. After the program finishes installing, click Finish.
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Group Policy (Push) Tool

To install Remote Administrator using the Group Policy (Push) tool:

Note: For help using the Microsoft® Group Policy Management tool, go to 
http://support.microsoft.com/kb/816102/. If using third-party software, refer to its user 
documentation for specific instructions on setting up a silent install of the 
LOCKOUT-PROTM application.

Note: Before installation, all of the group of PCs must have .NET 2.0 already installed.

1. Log in to the LOCKOUT-PROTM server.
2. Setup a shared folder to which all users have access.

3. From location [Install Directory]\LOPE\RemoteAdminInstall\, copy the file 
Lockout PRO Remote Admin.msi to the shared folder.

4. In Windows, select Start>Administrative Tools>Group Policy Management.

Note: The Group Policy Management tool is only available with Windows® 2003 Server 
and Windows XP Professional. It is a free download from www.microsoft.com if it is 
not already on your server.

5. In the Group Management Policy navigation panel, under Forest, locate your domain and server.

6. In the Domain window (on the right), right-click the Default Domain Policy, and select Edit.

7. From the Group Policy Object Editor window for your domain, choose from the following options to 
do a “Push” install for every:

• Computer: Under Computer Configuration, select the Software Settings folder.
• User: Under User Configuration, select the Software Settings folder.

8. Right-click on Software Installation, then choose New>Package.

9. Navigate to: My Network Places>Entire Network>Microsoft Windows Network>your 
domain>your server>[shared folder from step 2]>Lockout PRO Remote Admin.msi file.

10. Click Open.

11. In the Deploy Software window, choose Assigned, then click OK.

12. In the Group Policy Object Editor window, double-click the Software Installation entry.

13. If you chose “User” in Step 7:

a. Right-click the file Lockout PRO Remote Admin.msi, then select Properties. 
b. Click the Deployment tab.

c. Under Installation user interface options, choose Basic, then close the window.

14. The LOCKOUT-PROTM application will be installed on the user’s desktop:

• Users: At the next log on
• Computers: At next reboot.
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Setting Up and Managing Users

Primary Functions and Permission Levels
LOCKOUT-PROTM Graphical Procedure Writing Software includes three permission levels:

• Administrator: A user with Admin rights may perform all functions available in both the client 
and server components of the LOCKOUT-PROTM Client Application.

• Author: A user with Author rights may create and edit procedures from the client application, 
as well as view and print, but cannot modify templates, defaults, or the related information.

• Viewer A user with Viewer rights may only view and print procedures, lockout tags, energy 
source labels, and related information.

The Enterprise Manager utilities include two permission levels:

• Local: A local Administrator can perform all of the functions in the Enterprise Manager utility.
• Remote: A Remote Administrator can perform a subset of the functions in the Enterprise 

Manager utility.

Table 2 lists the primary functions and permission levels in the LOCKOUT-PROTM Graphical 
Procedure Writing Software and in the Enterprise Manager utility.

Table 2.  Primary Functions and Permission Levels

LOCKOUT-PROTM Software Functions Admin Author Viewer
View existing procedures
Print procedures, tags, energy source labels
View the related information
Modify the related information
Create new procedures
Revise existing procedures

Import earlier versions of LOCKOUT-PROTM files
Export procedures to other file formats
Save new or revised procedures
Edit procedure templates
Change default lists

Enterprise Manager Functions Local Remote
Administer client licenses
Maintain user permission levels
Transfer procedures between user groups
Manage Files
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Starting & Stopping Network Service
The Enterprise Manager provides simple one-click buttons to start and stop the network service when 
running the application on the server.

Note: You cannot start or stop network service from a remote installation of the Enterprise 
Manager.

To start or stop network service:

Note: Once the network service has been restarted, users must reconnect by either 
restarting the application or by selecting File>Connect from within the 
LOCKOUT-PROTM software.

Note: If this is the initial launch, the IP address for the local machine is selected by default. 
The Port select defaults to 8032. In subsequent launches, the Address and Port 
selected previously are shown.

1. If necessary, enter the appropriate IP Address or Server Name in the Address field.
2. Depending on the network configuration, enter the appropriate Port Number in the Port field.

3. To start the service:

a. Click Start to start the service. The application connects to the service and updates the status 
information. Once connection is established, all remaining functions are available to the Admin 
application.

b. If a message displays indicating that the application cannot connect, select the correct 
server IP address or server name from the drop-down list, then click Connect.

4. To stop the service:

a. Click Stop to stop the service. The application stops the service and updates all status information. 

Note: After the service is stopped, only the Service window is available until the service is 
restarted.
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Connecting to the Network Service
1. In the Enterprise Manager, click Service.

Note: If service has not been previously connected, the utility automatically opens to the 
Service window and all other buttons are unavailable.

2. Enter the IP Address and Port Number (if necessary).

3. Click Connect. Once the service is started, the remaining buttons are available.
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Managing User Groups
Each domain incorporates one or more user groups. Individual users in that domain must be assigned 
to a specific user group as part of the registration process. 

One of the benefits of user groups is that you can modify procedure templates to meet the needs of a 
specific group. For example, templates for a production group can include default wording or text 
formatting that creates the best procedures for that group, while templates for a research group can be 
edited differently for their specific needs.

To add a group:
1. In the Administrator window, click Groups.
2. Enter the name of the new group in the Name field.

3. Click Add Group. 



LOCKOUT-PROTM Enterprise Administrator’s Guide 21 

To delete a group:

Note: You cannot delete a group to which users are currently assigned. You must first 
reassign the users to a different group.

1. In the Administrator window, click Groups. 
2. From the Available Groups list, select the name of the group you want to delete.

3. Click Delete Group. 

a. If there are no users assigned to the group: Click Yes to delete the data and files for the 
selected group. The group folder and all data and files in the repository are deleted and the 
group is removed from the database.

Note: If you click No, the group is still removed from the database, but the data and files 
are left in the original repository folder. To delete the files, you will have to manually 
remove them.

b. If there are users assigned to the group: Assign the user(s) to a different group (or delete 
them) before deleting the group.

4. When finished, click OK.
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Managing Users
When a user first launches LOCKOUT-PROTM Graphical Procedure Writing Software on a client 
computer, a message is sent requesting that the user be added as a registered user. 

As administrator, you complete the user’s registration by accessing the user’s data on the Pending 
Users list, setting the permission level, and then adding the user name to the list of Registered Users.

You can also reassign registered users to different groups and/or change their permission levels.

To activate and register Pending users:
1. With the application open, click Users. 

2. From the Show drop-down list, choose Pending. A filtered list of all pending users displays.

3. In the Selected User area, choose a company for the user (Host Administrator only).

4. From the Group drop-down list, choose a Group for the user.

5. In the Status field, select Active.

6. If desired, change the permission level in the Permissions field.

7. Click Apply. The changes are updated and the user is removed from the Pending list.

8. Click OK to confirm the change.
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To manage existing users:
1. With the application open, click Users. 

To filter the users list:
1. Select one of the following filters from the Show drop-down list:

• All users (default)
• Active users (all users who are logged on)
• Pending users (users who have not yet been assigned rights for using the application)
• Inactive users (users who have been set to inactive by the Administrator)
• Users with licenses (these are only users with Admin rights. Authors and Viewers do not need 

licenses)
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To inactivate a user:
1. Select the user from the list of users.
2. In the Status field, select Inactive.

3. Click Apply. The user’s status is updated to “inactive” and will not be able to use the application.

4. Click OK to confirm.

To modify a user’s attributes:
1. Select All Users from the filtered list.
2. Choose a user whose attributes you want to change.

3. Change any of the following attributes:

• Group
• Permissions level

4. Click Apply. The user’s attributes are updated.

5. Click OK to confirm.

To delete a user:
1. From the filtered list, select a User.
2. Click Delete.

3. Click Yes to confirm, or No to cancel.
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To add a user:
1. To add a user, do one of the following:

• Click Add to enter the account name.
• To do a more specific search, click Advanced, enter more specific search criteria, then click 

Find Now (you can stop the search by clicking Stop). 
2. From the search results, select the desired account(s) and click OK. The application closes the 

search dialog and displays the account name(s) in the field.
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Managing Files & Folders
The enterprise version of the LOCKOUT-PROTM Administrator Application ensures procedure integrity 
by storing the procedures in a file repository on the server. By using groups and permission levels, it 
prevents unauthorized users from changing procedures and the file lockout feature prevents more 
than one user from changing a file at the same time. The ability to manage files also allows more than 
one group to make a copy of the same procedure files.

With the Administrator Application, you can perform the following operations: 
• Move files between different groups
• Copy, cut, paste, delete and rename files and folders
• Unlock files identified by a “locked” icon. These are files that are checked out for editing but 

cannot be checked back in because of technical problems (e.g., a PC crash).
• Display hidden .pdf files. A .pdf file is created for each .lop file and is hidden by default. Selecting 

this option displays the hidden .pdf files in the window.

Note: On the server, only the repository structure is shown and nothing above the top-level 
repository is displayed.

CAUTION: If “Show Hidden Files” is selected, the corresponding *.pdf files are not deleted 
when you delete the *.lop files, unless you explicitly choose to delete them. If 
“Show Hidden Files” is not selected, the application automatically deletes any 
corresponding (hidden) *.pdf files when you delete the *.lop files.

To add a new folder:

Note: You can only add a new folder to a group with folders below each group’s
“Files” folder.

1. With the application open, click Files & Folders. 
2. In the list of available files and folders, highlight a Group folder to which you want to add a folder.

3. In the right window, right-click and select New Folder (or click ).

4. Type a folder name and press Enter. The new folder will be added.
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To copy/cut files and folders:
1. With the application open, click Files & Folders. 

Note: Make sure the option Show Hidden Files is not selected.

2. In the list of available files and folders, highlight the file or folder you want to copy or cut. 

Note: You can choose more than one file or folder by holding the Shift key or CTRL key 
while clicking the items you want to copy or cut.

3. Click the option to Copy or Cut  the file or folder.
4. In the left window, choose the folder into which you want the file or folder copied.

Note: If a copy of the folder has already been created, the copied file or folder will be 
named Copy of xxx, or Copy (x).

5. Click Paste. 

Note: If any of the pasted files are .lop files, the application also pastes any corresponding 
.pdf files. PDF files are saved automatically when the enterprise client user saves 
the LOCKOUT-PROTM procedure file (*.lop).
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To delete files and folders:
1. With the application open, click Files & Folders. 

Note: Make sure the option Show Hidden Files is not selected.

2. In the list of available files and folders, highlight the file or folder you want to delete.

Note: You can choose more than one file or folder by holding the Shift key or CTRL key 
while clicking the items you want to delete.

3. Click Delete .

4. When prompted to confirm that you want to delete the file or folder, click Yes.

Note: If any of the deleted files are .lop files, the application also deletes any 
corresponding .pdf files.
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To unlock a file:
1. With the application open, click Files & Folders. 

2. In the list of available files and folders, highlight the file you want to unlock. A locked file appears 
with a “locked” icon.

3. Click Unlock .

4. When prompted to confirm that you want to unlock the file, click Yes. The application unlocks the 
file making it available to other users.

Note: If the original user saves the file back to the server after the administrator unlocks 
the file, any changes made since the file was unlocked will be lost.
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To rename a file:

Note: The Rename function is only available for files and folders below each group’s 
“File” folder.

1. With the application open, click Files & Folders. 
2. In the list of available files and folders, click a file or folder you want to rename.

3. In the right-side window, right-click the file or folder name (or press F2) and select Rename.

4. Type a new name and press Enter. The file or folder will be renamed.
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To show hidden files or folders:

CAUTION: If “Show Hidden Files” is selected, the corresponding *.pdf files are not deleted 
when you delete the *.lop files, unless you explicitly choose to delete them. If 
“Show Hidden Files” is not selected, the application automatically deletes any 
corresponding (hidden) *.pdf files when you delete the *.lop files.

1. With the application open, click Files & Folders. 
2. In the list of available files and folders, highlight a folder you want to view.

Note: The .pdf file for each .lop file is hidden by default. When Show Hidden Files is not 
selected, only the .lop files are visible.

3. In the right-side window, click the Show Hidden Files icon . The .pdf file(s) will display.
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Troubleshooting 

Viewing LOCKOUT-PRO™ Events
To view entries, you must be running the Event Viewer on the server (not remotely):

To view entries in Event Viewer:
1. Open the Windows Event Viewer (Start>Control Panel>Administrative Tools>Event Viewer).

2. To display the LOCKOUT-PROTM Enterprise events, select LOPE.

3. To see additional details for an event, double-click on the event.

Note: You should periodically save the LOCKOUT-PROTM event log by right-clicking the 
LOPE entry in Windows Event Viewer and selecting the Save option.

Troubleshooting Enterprise Functions
The following table shows the most common problems users are likely to encounter.

Error Conditions/Messages Possible Causes/Solutions
User cannot log on, because either all 
licenses are in use or the user account is not 
found.

1 The user is not a registered user. Users logging on for the 
first time may see this error if they remain in the Pending 
Users list.

2 The maximum number of floating licenses has been 
reached. The user will have to wait until another user logs 
out and releases a license.

The server is performing correctly, the 
company is assigned, the user is fully 
registered with appropriate permission levels 
and is assigned to a group, yet is still unable 
to log on to the server.

1 The user’s computer may be missing some needed files, 
such as: 
• MDAC 2.8
• .NET Framework version 2.0 or higher
Check if the files are installed (by using the Add/Remove 
Programs window from the Control Panel) or, for 
Windows 2000, check the folder: 
\windows\Microsoft.net\framework.

Note: Download any missing files from Microsoft’s website.
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Error Conditions/Messages
1. Verify that the network service is running.
2. Verify that the Network Address is correct.

3. Verify that the port settings are correct and that the port specified in the client configuration file 
matches that port setting.

4. If these steps do not solve the problem, please contact technical support.

Contacting Technical Support

United States and other C/S countries
Tel: 800-368-3362
Fax: 414-228-5799
Email: technical_support@bradycorp.com

Canada
Tel: 888-262-7576
Fax: 905-764-5557
Email: techsupportcanada@bradycorp.com

Mexico
Tel: 800-368-3362
Fax: 525-527-5586
Email: bradymexico@bradycorp.com

Brazil
Tel (PABX): 55 11 3686-4720
Tel (Direct): 55 11 3686-5697
Fax: 55 11 3686-5236
Email: brady_sevice_brazil@bradycorp.com
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